
Инструкция по установке ПО для комплекса приема спутниковых данных LEX.














Введение:
Для функционирования комплекса требуется совместная работа ряда приложений:

1. Orbitron - приложение для остлеживания положения спутников на орбите.
2. SDRSharp - приложение для записи работы с сигналом радио-приемника.
3. Zadig - приложение для установки драйвера радио-приемника.
4. Virtual Audio Cabel - вспомогательное приложение.
5. WXToImage - приложение декодирующее сигнал в реальном времени.

А так же ряда расширений для выше перечисленных программ.
Все файлы так же будут приложены к этой инструкции.

Система работает следующем образом: Orbitron отслеживает текущее положение выбранных спутников и когда спутник “поднимается из-за горизонта” передает SDRSharp полярные координаты и частоту компенсируя Эффект доплера.

P.S (Эффе́кт До́плера — изменение частоты и, соответственно, длины  волны излучения, воспринимаемой наблюдателем, вследствие движения  источника излучения относительно наблюдателя).

SDRSharp в свою очередь прослушивает сигнал с радиоприемника на частоте, которую получает каждую секунду от Orbitron, и выводит полученный сигнал на Virtual Audio Cabel. 

Далее в дело включается WXtoImage: приложение также самостоятельно отслеживает расписание пролетов спутников, (Не зависимо от Orbitron) и когда наступает начало приема запускает прослушивание звука с Virtual Audio Cabel и демодулирует сигнал, получая снимок. После приема и обработки WXtoImage покажет принятый снимок.
Если в SDRSharp выставить как устройство вывода динамики во время приема можно услышать ритмичный писк, напоминающий сигналы азбуки морзе.

[bookmark: _gjdgxs]Установка Orbitron.
1) Скачиваем программу по ссылке: 
http://www.stoff.pl/downloads.php

2) Запускаем установщик и разрешаем изменения на компьютере. 
3) Совершаем установку программы (все параметры можно оставить без изменений)
4) Программа откроется на весь экран. Закрываем «Окно сообщений» и в окне «Подтверждение» нажимаем «Нет». Выходим из полноэкранного режима. На клавиатуре нажимаем комбинацию клавиш «ALT+ENTER».

5) Приступаем к настройке. Переходим на вкладку «Место». 
вводим координаты антенны до 4 знака после запятой. (широта, долгота, высота над уровнем моря. Это важно!)

6) После ввода данных нажимаем кнопки «Добавить» и «Выбрать». Данные введены, и вы отобразились на карте:


7) Вызываем дополнительное меню, нажав на точку, и выбираем «Настройки». Второй способ нажать комбинацию клавиш «ALT+F5».

8) Переходим во вкладку «Карта» и выбираем желаемый вариант (Например Colored)

9) Переходим во вкладку «Обновление TLE». Ставим «Срок действия TLE» 3 дней и устанавливаем галочку «Обновлять группу автоматически»

10) Переходим во вкладку «Синхр. времени» и устанавливаем галочку «Синхронизировать часы компьютера при старте программы»

11) Сохраняем настройки нажав «Применить» и «OK». Теперь нам нужно обновить орбитальные параметры спутников. Для этого вызываем меню нажав на точку в верхней правой части программы и выбираем пункт «Автообновление TLE»




12) После окончания загрузки нажимаем «OK»

13) Далее нам нужно выбрать список метеорологических спутников, нажав на «Загрузка TLE»



14) Выбираем weather.txt и нажимаем кнопку «Открыть»

15) Загрузился список рабочих спутников:





16) Теперь можно выбрать интересующие нас спутники и посчитать расписание пролетов для них.
NOAA 15
NOAA 18
NOAA 19
Для этого необходимо сначала установить настройки расчетов, чтобы отсечь пролеты, которые нас не интересуют.

17) Устанавливаем интервал для расчета в 3 дня, Высоту спутника 20 градусов, Убираем галочки (Высота солнца и Требуется освещение).

18) После этого переходим во вкладку “расчет” и нажимаем Расчет.

19) После того как программа посчитает все пролеты нажимаем ОК и у нас должно отобразиться расписание пролетов спутников на 3 дня вперед.


Пример расписания:
Время                          Спутник              Азим. Выс. Зв.в Дист. С.ази С.выс
---------------------------------------------------------------------------------------------
2020-12-28 16:24:30 NOAA 19              108,0 20,0    ?  1892 236,5  -5,8
2020-12-28 16:27:35 NOAA 19               57,0 34,7    ?  1375 237,1  -6,1
2020-12-28 16:30:40 NOAA 19                6,4 20,0    ?  1899 237,7  -6,5

Оно собой представляет набор из трех строчек, которые описывают:
1) Момент, когда спутник из-за горизонта выше 20 градусов.
2) Момент, когда спутник поднимается максимально высоко.
3) Момент, когда спутник опустился ниже 20 градусов.

Закрываем Orbitron.







[bookmark: _1fob9te]Установка SDR#
Для работы системы нам требуется конкретная версия программы.
С более старой / новой версией работоспособность не гарантируется.
1) Скачиваем архив с программой по ссылке:
https://r4uab.ru/program/sdrsharp/sdrsharp-x86-v1.0.0.1361.zip
2) Распаковываем загруженный архив в C:\
3) Вставляем SDR-приемник в компьютер и запускаем zadig.exe
    (приложение, для установки драйверов для радиоприемника)
Программу можно найти в папке с SDR sharp.
Далее, в зависимости от того, какой у вас радиоприемник следует выбрать один из сценариев действий:

AirspySDR

У вас должно появиться вот такое окно:


Если в выпадаеющем списке ничего нет (там, где на фото написано AIRSPY), то необходимо выполнить следующие действия:


В выпадающем списке необходимо выбрать “AIRSPY”.
Убедитесь, что справа от зеленой стрелки выбрано “libusbK”

RTLSDR


В выпадающем списке необходимо выбрать “bulk-in interface (interface 0)”
Обратите внимание, нужно именно “bulk-in interface (interface 0)”, не 
     “bulk-in interface (interface 1)”. (В скобках должно быть interface 0)

Убедитесь, что справа от зеленой стрелки выбрано “WinUSB”
Теперь необходимо установить драйвер:

Если во время установки драйвера для произошла ошибка попробуйте: 
1. Нажав на стрелочку выбрать “Install Driver” вместо “Install WCID Driver”.
2. Подключить приемник к другому порту компьютера.


4) Запускаем SDRSharp и проверяем работоспособность Радио-приемника. Для этого необходимо выбрать наш приемник и нажать на запуск. (AIRSPY или RTLSDR(usb))



На данном этапе можно подключить антенну и попробовать поймать радио, регулируя частоту и коэффициент усиления. 

Это позволяет проверить работоспособность SDR и сигнального тракта от антенны.
Закрываем SDRSharp.

[bookmark: _3znysh7]

Установка Tracking DDE Client (Расширение для SDRSharp)
1) Скачиваем архив с плагином:
https://r4uab.ru/program/meteor-m/ddetracker_net35.zip
2) Разархивируем архив в папку SDR#
 (C:\sdrsharp)
3)  Добавляем расширение в настройки Orbitron:
(C:\Program Files (x86)\Orbitron\Config)

Открываем этот Файл от имени администратора  и вставляем в конец:
[Drivers]
SDRSharp=C:\sdrsharp\SDRSharpDriverDDE.exe
Обязательно сохраняем файл после редактирования!
Чтобы открыть файл от имени администратора необходимо сначала запустить блакнот от имени администратора, а потом открыть нужный нам файл.



4) Добавляем расширение в настройки SDRSharp: (C:\sdrsharp)

Открываем файл от имени администратора и добавляем следующие (в одну строчку):
<add key="DDE Tracking Client" value="SDRSharp.DDETracker.DdeTrackingPlugin,SDRSharp.DDETracker"/>

Обязательно сохраняем файл после редактирования!

5) Открываем Орбитрон и выбираем SDR# в качестве драйвера .

6) Нажимаем подключить. 


7) Подтверждаем установку драйвера.


8) Переходим в папку с SDRSharp и выбираем SDRSharpDriverDDE.



9) Устанавливаем правильные частоты для спутников.
Закрываем Orbitron.
https://r4uab.ru/frequencies-for-orbitron/
После загрузки и разпаковки архива запускаем приложение, в поле “Каталог установки” необходимо указать путь к папке Orbitron. Устанавливаем.


Правильные частоты:

	Спутники NOAA
	Диапазон частот (Мгц)

	NOAA 15 (В)
	137,6250

	NOAA 18 (В)
	137,9125

	NOAA 19 (+)
	137,1000




10) Не закрывая Орбитрон, открываем SDRSharp. Должен появиться новый плагин, который мы установили. Необходимо активировать пункт “Scheduler”.





11) Нажимаем на кнопку “Config” и создаем новый спутник (кнопка add new satellite), затем добавляем эти команды:



NOAA_15 (Название)

AOS (поле для ввода)
radio_center_frequency_Hz<137620000>
radio_frequency_Hz<137620000>
radio_bandwidth_Hz<38000>
send_tracking_frequency_On
radio_tracking_frequency_On
radio_Start

LOS (поле для ввода)
send_tracking_frequency_Off
radio_tracking_frequency_Off
radio_Stop

NOAA_18 (Название)

AOS (поле для ввода)
radio_center_frequency_Hz<137912500>
radio_frequency_Hz<137912500>
radio_bandwidth_Hz<38000>
send_tracking_frequency_On
radio_tracking_frequency_On
radio_Start

LOS (поле для ввода)
send_tracking_frequency_Off
radio_tracking_frequency_Off
radio_Stop


NOAA_19 (Название)

AOS (поле для ввода)
radio_center_frequency_Hz<137100000>
radio_frequency_Hz<137100000>
radio_bandwidth_Hz<38000>
send_tracking_frequency_On
radio_tracking_frequency_On
radio_Start

LOS (поле для ввода)
send_tracking_frequency_Off
radio_tracking_frequency_Off
radio_Stop


[bookmark: _2et92p0]

Установка Virtual Audio Cabel.
1) Переходим по ссылке и скачиваем установочный файл: https://vac.muzychenko.net/en/download.htm

2) После скачивания запускаем его и устанавливаем виртуальный аудио кабель.
[bookmark: _tyjcwt]
Установка WXtoimg
1) Переходим по ссылке и скачиваем установщик:
https://yadi.sk/d/D07cCtC3jRi5Qw
2) Совершаем установку программы, без изменения настроек.








3) При первом запуске WXtoimg необходимо настроить свое местоположение. Перейдите в раздел Options → Ground Station Location введите название города и укажите его координаты.


Указываем координаты, а также название города и страны. Кнопка Lookup  Lat/Lon (Получение координат по названию города) не работает для Российских городов.


4) Затем переходим в раздел Options → Recording Options и настраиваем источник звукового сигнала. В разделе soundcard указываем CABLE Output. Обратите внимание и сравните все настройки!


5) Также необходимо установить то же устройство в SDRSharp,  в качестве выходного для принимаемого сигнала.


6) Затем необходимо обновить информацию о координатах спутников. Перейдите в раздел File → Update Keplers. После выполнения обновления в левом нижнем углу появится подтверждение.
.
[bookmark: _3dy6vkm]

[bookmark: _1t3h5sf]Прием сигнала со спутника:
За несколько минут до начала приема рассчитанного Orbitron следует выполнить следующие действия:
1) Открываем программу. 

После необходимо запустить SDRSharp

В плагине DDE-трекер должен подгрузиться выбранный спутник его текущий азимут и высота.
2) Запускаем WXtoImage (он запускается достаточно долго, примерно секунд 10-15)

3) После этого переходим в меню файл и выбираем вкладку рекорд:









4) После этого должно открыться окно. Чтобы после приема автоматически сохранились аудио файл и картинки, надо выбрать следующие настройки:

После чего нажимаем “Auto Record” . Теперь WXtoImage сам запустит запись при приближении спутника.

5) Ожидаем пролета спутника.









Если на экране Вы видите вот такую картинку, то установка и настройка ПО прошла успешно, и в данный момент идет запись сигнала с метеоспутника.


[bookmark: _4d34og8]Удачного приема!


22
image1.png
Satellite tracking « HAM radio * IS5  Visual observing * Tracking software ¢ Iridium flares ¢ Satellite tracking at home

ECl==i N
e N

& [ More languages ]
Orbitron 3.71 Installer, size: 2 MB E After download zipped TLE data, please extract it to Orbitron\TLE directory. You can safety overwrite existing ones. TLE files are

Newest officially released version of Orbitron (EXE - installer). updated every day from: www.celestrak.com and www.io.com/~mmccants/.
Orbitron 3.71 ZIP version, size: 1.7 MB TLE.ZIP, size: 80 kB
Newest officially released version of Orbitron (ZIP - packed). ’ Ny
Translator 2.51, size: 370 kB Content: All Celestrak TLE groups (official) + Elements for dlassified objects (unofficial)
Please use this application to make your language version of Orbitron. All translations will be shared to other people as soon

i overs

Driver is an application working as DDE Client. It receive tracking data from Orbitron and send it to rotor/radio hardware via

‘COM/LPT/USB interfaces.
- - . - My DDE Client 1.05
After download one of ZIP files below, please extract it to Orbitron\Data directory. Then run Orbitron, enter the setup (Alt+F5) This is example of user's custom driver for Orbitron. It contain EXE file and full source code in Delphi 5. Also, specification of
and choose your new map in World map configuration panel. DDE drivers for Orbitron is included.
Clouds 680 kB, 800x400  Preview Spidalfa 0.97
Driver for Spid rotor (Rot2proG).
Coloured HiRes 810 kB, 1000x500 Preview Spidalfa 0.97 sources
Coloured 2 530 kB, 1000x500 Preview Delphi 5 sources for Spidalfa driver.
Alarm Driver 0.91
Contour 560 kB, 600360  Preview This driver provides signal on pin 7 of choosen COM port as AOS notification.
; y Spidbriver (external link)
Contour HiRes 2600 kB, 1440x720 Preview Unit . for Spi by SQ . . 3.50 or higher required.
Flat 290 kB, 600x360 Preview
G cmomem e Fesfomuses
Winter 930 kB, 1200x720  Preview Following files were sent to me from Orbitron users. Maybe you find it useful. Each archive contains short instruction of use. Feel
Political 100 kB, 600x360  Preview free to send me your maps, radar backgrounds or so. Interesting files will be published on this site.
Standard HiRes 66 kB, 2048x1024 Preview Astra

Astra satellite theme for Orbitron sent by Tomasz Wierszalowicz.
Night HiRes 819 kB, 2400x1200 Preview Chinese help files, 2004.12.15
Please extract this ZIP to ...\Orbitron\ directory.

Addtonatarsatons
Please extract this ZIP to ...\Orbitron\ directory.

Orbitron installer contain over 30 translations, but few are distributed separately. Please download translation you need and unzip Afrikaans help files, 2005.03.21

to Orbitron\Lang directory. Then run Orbitron, enter the setup (Alt+F5) and choose your language on Miscellaneous tab. Please extract this ZIP to ...\Orbitron\ directory.
Available translations (size about 10 kB): Japanese Orbitron Quick-Starting Guide, 2005.06.06
Galego (Galician), 2005.09.22, v3.71 Online documentation.

Ttaliano (Italian) - alternative, 2005.08.29, v3.70
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If this new version works not as described, try the last knowingly stable version 4.65: self-installing
EXE or ZIP archive.

Lite version can be used only in a private home environment not associated with income generation.
Here is a feature comparison table:

Feature Lite version | Trial/full versions
Maximum number of Virtual Cables 1 256
Maximum sampling rate 48000 384000
Maximum bits per sample 16 32
Maximum number of channels 2 32
Minimum milliseconds per event 3 1
Maximum number of worker threads 1 32
Maximum number of clients 1 Unlimited
Multi-client support No Yes
Stream format limiting support No Yes
Channel remapping support No Yes
Microphone and S/PDIF type lines No Yes
Position and clock register support No Yes
Cost Free 15-50 USD
Usage policy Home only | Home/business
Technical support Bugsonly | Full support

The easiest way to open the user manual is to click the "Help" button in the first installation dialog,
or in VAC Control Panel window (if already installed).
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